GRADUATE
COLLEGE

Manual for Formatting the Tables and the List of Tables in the
Thesis or Dissertation

This manual provides information on:
* How to properly format tables within the thesis or dissertation.
* Examples of properly formatted tables.
* The format requirements for the List of Tables.
* How to manually and automatically create a List of Tables. An example of a
properly formatted List of Tables is provided at the end of the manual.

Sections:
Section 1: Formatting Tables within the Thesis or Dissertation (p. 2-5)
* General Formatting Guidelines (p. 2)
* Inserting a Caption for a Table in Microsoft Word (p. 2-5)
* Samples of Properly Formatted Tables (p. 6-8)
Section 2: Format requirements for the List of Tables (p.9)
Section 3: How to Manually Create a List of Tables (p. 10-11)
Section 4: How to Create a List of Tables Automatically in Microsoft Word (p. 12)
Section 5: Samples List of Tables (p.13)
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Section 1: Formatting Tables within the Thesis or Dissertation

General Formatting Guidelines

* Besure that all inserted tables are labeled with a TITLE and NUMBER

o Example: Table 1. Total Number of Graduate Students from 1986 — 1997

* The numbering for each table must be consecutive, per the requirements of your
chosen style guide.

o Numbering can be from the beginning of the document or from the start
of each chapter.

* Your casing choices must be consistent and match between all of the table labels
and should follow the requirements of your chosen style guide.

o For example, if your titles are in ALL CAPS in your text, they will need to
be in ALL CAPS in your list of tables and throughout your other table
titles. The rule applies to titles that are Title Cased, lower cased, or Just
capitalize the first word of your title.

* |f atableis landscape oriented, the table’s label and page number must be
landscape oriented to match.

* TABLES MUST BE CLEARLY DELINIATED FROM THE TEXT. This can be done by
done line breaks (minimum 2 line breaks or 2 double-spaced lines), borders, or a
delineation that is approved by your style guide. The title and description of
tables are considered part of the table and must be clearly delineated from the
text as well.

* Tables embedded into your document must fit on a single page. You can use
smaller font size on tables, but it cannot be below 8 point size. If the embedded
item does not fit within your text on a single page, it must be reasonably split or
moved to the appendix. You can either give each table its own appendix or you
can create a single appendix containing multiple tables.

* Unlike the rest of your document, the descriptions and titles of tables embedded
in your document can be single-spaced.

* You must use the same font style as the rest of your document. As noted above,
the font size can be smaller than the rest of the font size in the document.

Inserting a Caption for a Table in Microsoft Word:
Using this function in Microsoft Word enables you to ensure that there is consistency
among table titles throughout your document. These captions will also then enable you
to automatically create a List of Tables. REMEMBER: All tables need to be formatted
identically with each other.

1. Find your first table in your document.

2. Position your mouse cursor at the beginning of the table’s title/description. Go

to the References tab.
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3. Onthis tab, select Insert Caption. This is located in the center of the References
tab under the Captions section.

Word File Edit View JUECE Format / Font Tools

?-EmEE e Date and Time...

# Home | layout | D¢  AutoText > | o

Insert Pages. Table

s  Footnote...
. Caption...
Cross-reference...
Index and Tables’..

Table...
Chart...
SmartArt Graphic...

Photo
Audio
1 Movie
E Clip Art
Symbol
Shape...

vyVYyVvYYVYY

4. A menu will pop up and look similar to the image below.

Caption

Caption: ‘Table 1|

Options
Label: New Label...
Position: Cted item < Delete Label
Numbering...

AutoCaption... Cancel ﬁ

5. Make sure the word “Table” is displayed in the Label section. If it does not, click
on the down arrow in the Label section and select it from the list.

6. When the caption figure says “Table 1,” click OK.

7. The label “Table 1” should appear in front of your caption. You will notice that
Word has changed the label and description of your table to its default settings.

Table 1UNLV’s Student Population Preference for Chocolate or Vanilla Cupcakes (By Class-Standing).

tudent Status Prefer Chocolate Prefer Vanilla wﬁr
Cupcakes Cupcakes Upcakes
Undergraduate Students
Freshman 565 400 52
Sophomore 787 878 115
Junior 412 432 25
Senior 125 200 300
Graduate Students
Graduate 325 250 212
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8. You can change the caption formatting style by going to the Home tab. There
you will see the Styles section in the ribbon. In the lower right-hand corner of the
Styles section, you will see an arrow. Click on the arrow to bring up the Styles
menu.

9. Click anywhere on the caption (label or description) and this displays the
Captions option in the Styles menu.

10. Click on the down arrow located to the right of “Caption.”

Style

Styles:
»- Caption
» 4 Default Paragraph Font
»:= No List

Paragraph preview

Norma
FH Table Grid
[ Table Normal

Character preview

+Th Bod: =
eme Bo
y 9 pt
List: Description
Styles in Use B Font:9 pt, Bold, Font color: Accent 1, Space After:
10 pt, Style: Hide until used, Quick Style, Priority:
36, Based on: Normal, Following style: Normal
Organizer...

G ply |

11. Choose Modify.

12. This is where you can modify the font style, font size, the position of the label
and descriptions (e.g., centered, left-aligned), and the line spacing (e.g. single-
spaced).

Modify Style
Properties
Name: Caption 1
Style type: Paragraph S
Style based on: I Normal B
Style for following paragraph: 9 Normal E
Formatting
Calibri (Headings) w10 B I U _é_ v
(
5
Font:+Theme Headings, 10 pt, Space After: 10 pt, Style: Hide until
used, Quick Style, Priority: 36, Based on: Normal, Following style:
Normal
Add to template Add to Quick Style list Automatically update |
‘ Format cancel (RSN |
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13. Once you have fixed the style of the caption, click OK. The caption for your table
should reflect these changes. From here, all captions for your tables should look

the same.

14. To insert a caption for the rest of the tables in your document, follow the above
steps.

15. The only change is that instead of making sure the label is “Table 1” (Step 7
above), the number must be changed to accurately reflect the order of the

respective table.
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from the text (2 line

NOTE: Label and
description for

double- d
Oubr:ai'z;ce Sample 1: Properly Formatted Tables

each table are
formatted the
same.

Section 1: Fun With Latin
Eius solum similique pri te, errem decore perpetua an his. This idea is clearly illustrated

in Tables 1.1 and 1.2.

Table 1: UNLV’s Student Population Preference for Chocolate or Vanilla Cupcakes (By Class-Standing).

Student Status Prefer Chocolate Prefer Vanilla Prefer Other Type of
Cupcakes Cupcakes Cupcakes
Undergraduate Students

Freshman 565 400 52

Sophomore 787 878 115

Junior 412 432 25

Senior 125 200 300

Graduate Students

Graduate 325 250 412

Table 2: UNLV’s Student Population Preference for Cats or Dogs (By Class-Standing).

Student Status Prefer Cats Prefer Dogs Prefer Other Type of
Animal
Undergraduate Students
Freshman 200 125 50
Sophomore 325 330 41
Junior 87 98 125
Senior 225 275 300
Graduate Students
Graduate 574 300 25

Section 2: Fun With Latin Revisited
This next section explores text text text text text text text text text text text text text

text text text.
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Sample 2: Properly Formatted Tables

Section 3: Fun with Latin — The More You Know

Ne salutandi consetetur theophrastus mei, illum choro cu nec. Dico dolor intellegam quo
et. Id qui stet facilisi, aperiri ceteros probatus ei est. Vix harum homero noluisse te, alia
tota ne usu. Ut iusto laboramus consequuntur duo, ea sale nihil assentior quo. Vix paulo

mollis ne. Legimus molestie luptatum ea pri.

Eius solum similique pri te, errem decore perpetua an his. In sale nulla nusquam eam.
An sed euripidis interesset, homero disputando quo ad, est reque viderer cu. Petentium

accusamus has ex, eu sale reque lobortis per, his tollit corpora appareat ei.

Te modo dolore iriure vis. Error bonorum vix ea, te nam quidam fierent moderatius.
Nobis sapientem democritum cu sit. Et invidunt delicata aliquando eos, volutpat
adolescens id vix. Eu qui invidunt erroribus. See Table 3 below for a detailed breakdown

of student prefrences.

NOTE: This might seem like a lot of space, but if you look on the next page (p. 7) the table takes
up almost a full page. This much space is allowed if your table (or figure) would not fit in the
space remaining on the respective page.

Remember: The table cannot be split onto two pages. It must fit on one page or it will need to
go into an appendix.

Also, note that the text on Table 3 is smaller than the other two tables. This is allowed.
However, the font style is the same between all three tables. Furthermore, the caption/
description are the same font style, font size, paragraph spacing, and casing for all three tables.
This must be the case for all tables in your document.
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Table 3: College of Liberal Arts Students’ Preferences for Chocolate Chip Cookies or Oatmeal Raisin

Cookies.

Department/ Student Class-

Prefer Chocolate Chip Cookies

Prefer Oatmeal Raisin Cookies

Prefer Other Type of Cookie

Standing
Department of Anthropology
Freshman 42 53 99
Sophomore 112 205 20
Junior 51 54 102
Senior 99 89 199
Graduate 15 205 2
Department of English
Freshman 34 52 125
Sophomore 69 78 1
Junior 152 2 3
Senior 159 201 63
Graduate 32 23 1
Department of History
Freshman 23 65 123
Sophomore 152 2 3
Junior 51 54 102
Senior 99 89 199
Graduate 15 205 2
Department of Philosophy
Freshman 65 56 66
Sophomore 99 102 32
Junior 212 321 2
Senior 56 87 9
Graduate 12 22 33
Department of Political Science
Freshman 5 97 186
Sophomore 4 3 2
Junior 12 15 22
Senior 98 98 5
Graduate 5 5 3
Department of Psychology
Freshman 45 36 2
Sophomore 89 98 9
Junior 23 3 99
Senior 32 22 12
Graduate 2 32 10
Department of Sociology
Freshman 23 32 333
Sophomore 26 26 3
Junior 105 115 1
Senior 2 5 7
Graduate 3 3 6
Department of World Languages and Cultures
Freshman 56 65 79
Sophomore 112 115 3
Junior 115 112 59
Senior 23 65 2
Graduate 2 2 9
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Section 2: Format Requirements for the List of Tables

The List of Tables is placed immediately before the List of Figures (if you also have a List
of Figures).

It must be labeled as “List of Tables”
The List of Tables is mandatory only if there are 5 or more tables found in the
document. However, you can choose to have a List of Tables if there are 4 or less
tables in the document.
Regardless of whether you are required to have a List of Tables or if you chose to
have a List of Tables, all tables included in your text and appendices must
appear in your List of Tables.
Furthermore, if you chose to have a List of Tables, you are bound by all list
formatting rules and you must include all tables on the list (found in both the
document and the appendices).
The page numbers listed in the List of Tables must match the page number as
they appear in the text.
The label and number for each table listed in the List of Tables must match
exactly as they appear in the text.
The label is considered to be the first sentence after your listed table number.
This sentence must match verbatim between the List of Tables and the text.
Your casing choice must also match between your table label in the text and in
the List of Tables.

o For example: if your List of Tables contains Table 4b: Oatmeal Consumed

from 1820-1851; the corresponding table label in the text should be
Table 4b: Oatmeal Consumed from 1820-1851.

The format used for your List of Tables must match the formatting style of your
Table of Contents, List of Figures, and any other lists included in your front
material.
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Section 3: How to Manually Create a List of Tables

This method is almost identical to how you would manually create a Table of Contents
(see Table of Contents Manual and Manual for Formatting the Figures and the List of
Figures in the Thesis or Dissertation) in Microsoft Word.

On the List of Tables page:

1. Make sure you have the Heading “List of Tables” on the page. Be sure that it
follows the format for all other major headings throughout the document (See
Headings and Subheadings Manual for help with formatting major headings
using the Style guides in Microsoft Word.)

2. Type the first entry. Remember:

a. Table Number and Label
b. Make sure the font style, font size, and casing match between the List of
Tables and the text.

3. Press Tab and then type its respective page number (Remember: make sure the
page number matches exactly between the document and what is listed on the
List of Tables)

4. Then select the Tab stop character. In order to show the Tab stop character, click
the Home tab. Then click Show/Hide in the paragraph group.

B & 0 )- B @ [ooxls] @ (@

Document Elements Table SmartArt | Review
Paragraph Sty
Cambria (Body) |v| 12 |~ A~ A~| Aa~ AP/ = " 32\ = IE2E) D AaBbCcDc
B | I |U |46 A Al A |- A [B= = =M 004 Normal
ry, T R R R R Y LBl

5. Click the arrow found at the bottom left hand corner of the paragraph group.
6. This launches the Paragraph Dialog Box. Click the Tabs button.

Paragraph
(EEEEIEEEEIEN Line and Page Breaks
Alignment:  Left kJ Outline Level: Body text ]
Indentation
Left: |0 2 Special: By:
(none) B
Right: 0"
Spacing
Before: 0 pt 2 Line spacing: At
Single B
After: 0 pt
Don't add space between paragraphs of the same style
Preview
Cancel | (TSN

10




Updated by GC SST Fall 2019

7. Type 6.4” under the Tab stop position. This means that your number will end in
the 1” margin (REMEMBER: ALL MARGINS, INCLUDING THE RIGHT MARGIN, FOR
THE THESIS OR DISSERTATION MUST BE 1”).

Tab stop pgsition:

6.4

Tab stops to be cleared:

Set

Clear

Tabs

0.5"

<>

Default tab stops:

Alignment

Left

Center

© Right

Decimal

Clear All

>
[ OK |

Cancel

8. Under alignment, click Right.

9. Under Leader, choose item 2. The Graduate College style guide does not allow

for leaders.
10. Click Set and then OK.

11. Press Enter. Type your next entry, press Tab, and then type the respective page

number.

Repeat until your List of Tables is finished.

11
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Section 4: How to Create a List of Tables Automatically in

Microsoft Word

Adding captions via the Captions section (under References tab, enables you to
automatically create a List of Tables in Microsoft Word. Make sure that your captions
have been properly inserted and modified. If they are not, then it will cause issues when
you try and create your List of Tables.

1.
2.
3.

Go to your blank List of Tables page.

Hit enter so that have a blank line underneath the List of Tables heading.

Click the References tab. Select the Insert Table of Figures, found in the Captions
section.

The Table of Figures menu will appear. Yours should look similar to the one
below.

Make sure the caption label says “Table.”

In order to modify the font size, font style, and make sure the List is double-
spaced, click on the modify button. This will bring up another Style menu. Click
modify again and this will bring up the Modify Style menu.

Once you have made the necessary changes, click OK (all three menus).

The List of Tables will be generated.

Remember: Similar to the Table of Contents, you cannot fix any misspellings or spacing
problems on the List of Tables itself. Instead, you will need to go to the caption itself
and make the corrections. You will then need to update the List of Tables to reflect the
changes.

Updating the List of Tables:

There are two options to update the List of Tables.

First Option: The first is that under the Modify Style menu (Step 6 above), you

can click “Automatically update.” This will ensure that any changes made to the

tables (caption spelling or their placement) will be automatically updated on the

List of Tables.

Second option:

1. Navigate your mouse to the Table of Contents itself. Right-click within the
Table of Contents. It will turn grey and two menus will appear.

2. Select the “Update Field.” Another menu will appear.

3. Choose “Update entire table” and click OK. This will update your List of
Tables to reflect any changes you may have made to the tables’ captions or
placement in the document.

12
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Sample: List of Tables

List of Tables

Table 1: UNLV’s Student Population Preference for Chocolate or Vanilla Cupcakes (By
Class-StANING). .eeeeeeiiiie e e et e e e e et re e e e e e e saba e e e e e e e araeaeeeeennnraeeeeeanns 6

Table 2: UNLV’s Student Population Preference for Cats or Dogs (By Class-Standing)...... 6

Table 3: College Of Liberal Arts Students’ Preferences for Chocolate Chip Cookies or
0atmeal RAISIN COOKIES. .eiiiiuuiriiiie ittt eesit et e e e eire e e e s s s re e e e e e s sbbareeesssabraeeeessnnns 8

NOTE: The table number and NOTE: The page numbers listed in the
label for each table listed on the List of Tables match the page number
Table of Contents match exactly as they appear in the text.

as they appear in the text.

GENERAL NOTES:

- The List of Tables is labeled as “List of Tables.”

- If your description is several sentences long, only the first sentence
after your listed table number needs to appear on the List of Tables.
This sentence must match verbatim between the List of Tables and
the text.

- The List of Tables heading must match the format of all other major
headings in the document.

13



